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Abstract

These Application Notes describe the configuration steps required for NMS Adaptive Call
Recording module to interoperate with Avaya IP Office. Adaptive Call Recording is one module of
the NMS Adaptive Suite which allows the recording of inbound and outbound phone calls.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the compliance tested configuration used to validate the NMS
Adaptive Hybrid Call Recorder module of the Adaptive Suite with Avaya IP Office using a PCI
Call Recording Board from OptiLogix. The Adaptive Suite interoperates with Avaya IP Office
using third party Telephony Application Programming Interface (TAPI). A module of the
Adaptive Suite, the Adaptive CTI Gateway handles all communication between the Adaptive
solution and Avaya IP Office.

NMS Adaptive is a Computer Telephony Integration platform that provides call control, media
blending, progressive and predictive dialling and monitoring functionality to end users. Adaptive
Desktop allows operators to control making and receiving calls via an Avaya handset registered
to the Avaya IP Office. The Adaptive Hybrid Call Recorder is a trunk-side recorder that records
all telephone calls made and received. The Adaptive Call Recorder is called hybrid because it
can be configured to record from any mixture of SIP, Analogue, and T1/E1 telephone lines,
Adaptive Hybrid Call Recorder will also be referred to as Adaptive Call Recorder throughout the
document. Recordings are stored on a central PC and can be searched and played back. They can
also be exported in an industry-standard WAV format. Recordings can be backed-up and
archived using any standard computer media including: Tape, DVD and Network Attached
Storage (NAS). An integration toolkit is available for customers who wish to access call
recordings through their own applications. The calls are recorded using either a USB connected
unit or a PCI card that is fitted inside the computer.

2. General Test Approach and Test Results

The interoperability compliance testing included feature and serviceability testing. The feature
testing focused on verifying NMS Adaptive Call Recorders handling of CTI messages in the
areas of call control, event notification and routing. Various types of calls including intra-switch,
PSTN, outgoing and incoming calls were tested. The compliance testing focused primarily on the
following types of calls:

e Basic Inbound/Outbound Calls

e Hold/Transfer Functionality

+ Search and playback of call recordings
+ Failover Testing

The serviceability testing focused on verifying the ability of NMS Adaptive Call Recording to
recover from adverse conditions, disconnecting the Ethernet cable for the CT1 link and the reboot
of the Adaptive server under test.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
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DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Compliance testing

The compliance testing focused primarily on the recording and playback of the following types
of call:
e IP Office Inbound/Outbound calls— Test call recording for inbound/outbound calls
to/from the IP Office users from PSTN callers.
¢ |P Office Hold/Transferred/Conference calls — Test call recording for calls transferred
to and in conference with PSTN callers.

The serviceability testing focused on verifying the ability of NMS Adaptive Web Assist to
recover from adverse conditions, disconnecting the Ethernet cable for the CTI link and the reboot
of Adaptive server under test.

2.2. Test Results

All tests passed successfully however the following observations were noted during testing:
[1] Adaptive Desktop does not login a user as a part of the CTI functionality. Call Control
is taken for a user already logged in to an extension.
[2] Only blind transfers are possible using Adaptive desktop.

2.3. Support

For technical support on NMS Adaptive products, please contact the NMS Adaptive support
team at:

Web address http://www.nms-adaptive.com/support-options.html
Telephone ; +44 845 612 4000
Email : support@nms-adaptive.com

3. Reference Configuration

Figure 1 shows the network topology for compliance testing. NMS Adaptive Call Recorder
which resides on a Windows 2003 Server with IP Office TAPI3 Service Provider to provide CTI
connection to Avaya IP Office. Avaya 2400 Series digital deskphones are associated with
Adaptive Desktop operators giving each Adaptive Desktop operator telephony functionality from
the IP Office.
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Figure 1: Connection of NMS Adaptive Hybrid Call Recorder with Avaya IP Office R8
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4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment/Software

Release/Version

Avaya IP Office 500

Avaya IP Office R8.0.16

Avaya 96xx H.323 Deskphone

Avaya H323 IP Office Firmware
Ha96xxua3_Hbas.bin

Avaya 2420 Digital Extension

N/A

Avaya TAPI3 Telephony Service
Provider Client for IP Office Installed on
Adaptive Server.

Avaya TSPI3w.tsp 1.0.0.17

Platform Independent Server with
Windows 2003 Server O/S and NMS
Adaptive Server.

NMS Adaptive Hybrid Call Recorder Release 9.4

OptiLogix PCI Call Recording PCI board

Release 9.4

Client Workstation with Windows XP
and NMS Adaptive Desktop

NMS Adaptive Desktop Release 9.4
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5. Configuration of Avaya IP Office

IP Office is administered using IP Office Manager installed on a PC. It is assumed that a working
IP Office is in place with extensions and users preconfigured. This section shows what changes
to the IP Office configuration is required for NMS Adaptive Call Recorder to interoperate
correctly.

Note: A user must be logged into the extension before the Adaptive Desktop can assume control
of the extension.

5.1. Configuration of Avaya IP Office Users

Each user will need to be configured to allow the do not disturb feature. Click on User Rights in
the left window and select the user right associated with the users. In the example below, this is
called Agent. Under the User tab ensure Enable do not disturb is ticked as shown. Enter a
suitable Name for the User rights as this will be referenced in the User configuration to follow.
Click OK once the information is entered correctly (Not shown).

i Avaya IP Office R8 Manager 00EO0702DB9A [B.0(16)] [Administrator{Administrator)]
File Edit View Tools Help

i 0DEDO702D89A ~ User Rights + Agent AR EEE \ v 28

IP Offices

89025 Occ Inspect ~
9500 paulg9s00 =
89901 popey Mame |Agent
59107 SIP Handset i
500 TAPI:S00
501 TAPL:501 § ~| Mot part of User Rights v
502 TAPL:S02 : — —————— =
503 TAPL:S03 Priority
89021 Vacant Clean |s v | Mot part of User Rights v \
89022 VacantInspected = — =
89020 Yoicemail 2 Do not disturb
89300 YoiceMail SIP
89301 Voicemail SIP1
89302 Voicemail SIP2
& 89303 Yoicemail SIP3

[+ f§ HuntGroup (5)
(-8 Short Code (66)

B service (0)
ol RAS (1)
# Q Incoming Call Route {3)

@ WanPort {0}

o Directory (0)

£ Time Profile (0)
# @ Firewall Profile (1)
i+ [l IP Route (2)

#m Account Code (0)
[+ @, Licence (58)

& Tunnel (0

Configuration Ite... Record Description

Locale

Enable do not disturb | Mot part of User Rights v/
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Expand on User in the left window and select the user to modify. Under the User tab in the right
window, ensure that Working hours User Rights is set to that user rights configured above.

2 Voicemail DND ‘ ShortCodes | Source Numbers | Telephony “ Forwarding | Dial In | Yoice Recording | Button Programming

‘ ::isoireManager System Phone Rights 7[None v \

b 8911 ExtB911 Profile | Teleworker User v
204 Extn204
205 Extn20S
206 Extn206 Enable Softphone
207 Extn207
208 Extn208
8004 Extna004 Enable one-¥ TeleCommuter
89000 EXTE9000 Enable Remote Worker
89001 Extn89001
89002 ExtriBo002 [ Ex Directory
89003 Extn&9003 ! =
89004 ExtnB9004 Device w Avaya 2420
89005 Extng900s Type

9006 ExtnB9006 User Rights

89007 Extn&9007
89011 Extna9011 User Rights view [Worldng hours User Rights v ‘
89012 Extn89012
89013 Extn89013
89014 Extn89014 Working hours User Rights !Agent v ‘ I
89015 Extn89015
39016 Extn39016 il Out of hours User Rights
89017 Extn89017 —

59018 Extn89018
wac310Extnas1o [l

2010 Evkn2010

[] Receptionist

Enable one-X Portal Services

Working hours time profile

1
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6. Installation and Configuration of Avaya IP Office TAPI3
Service Provider

TAPI3 Service Provider is included in the IP Office CTI Link Software Development Kit (SDK)

located on the DevConnect website (http://www.avaya.com/gcm/master-usa/en-

us/corporate/alliances/devconnect/index.htm ) under the product name IP Office. Once

downloaded, the install is initiated by running TAPI3Install.exe as shown below.

Z‘L @ C:\Documents and Settings',Administrator'Desktop'SDK 2.0 DEVCONNECT SITE

My Computer File  Edit

View Favorites Tools Help

Bk v &) v ¥ | S search [ Folders | 1 4 X ) ‘ (-

yf:__[, Address Il[j C:\Documents and Settings\Administrator\Desktop|SDK 2.0 DEVYCONNECT SITE
'—D‘ Mame | Sizel Type | Date Modified | Attributesl

putty exe html | File Folder 07/11/2011 13:47
[2)5amples File Folder 071112011 13:47
}Autorun.inf 1 KB Setup Information 03/10/2001 11:41 A
& ao 1 KB Shortcut ko Program 03/10/2001 17:31 A
@go.bat 1 KB Windows Batch File 12/12/2001 16:38 A
€ index.htm 4 KB HTML Document 12062006 10:26 A
E] readme.txt 1KB Text Document 22/10{2003 12:59 A
= = 1KB Text Document 120712006 13:38 A
@TAPISInstaII.exe 3,637 KB Application 22/10/2003 16:19 A

To configure the TAPI Service Provider, navigate to Control Panel and right click on Phone
and Modem Options highlighted below and select properties (not shown).
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Click on the Advanced tab and highlight Avaya IP Office TAPI3 Service Provider and click
Configure.

Phone and Modem Options N 2l x|
Dialing Rulesl Modems l

h! = The following telephony providers are installed on this computer:

B A 2 ey
Microsoft H.323 Telephony Service Provider
Microsoft HID Phone TSP

Microsoft Multicast Conference TAPI Service Pravider
NDIS Prosy TAPI Service Provider

TAPI Kemel-Mode Service Provider

Unimodem 5 Service Provider

Add... | Remove Configure... |

oK I Cancel | Soply |

Enter the IP Office IP address into the Switch IP Address box. Select Third Party and enter the
IP Office Administrators password into the Switch Password box. Ensure WAV Users and
ACD Queues are ticked as shown below.
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|Avaya TAPI3 configuration

- [192.168.30.31
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7. Configuration of NMS Adaptive Hybrid Call Recorder

This section outlines the steps necessary to configure the NMS Adaptive Call Recorder to enable
the recording of all voice calls across the E1/T1 link. All configuration changes on the Adaptive
Server are done through Adaptive Management Console installed on the Adaptive Server.

Note: Installation of the Adaptive Call Recorder software is outside the scope of this document
and information regarding the installation can be found in Section 11 of these Application Notes.
7.1. Configuration of NMS Adaptive CTI Gateway

The steps below describe the configuration for Adaptive CTI Gateway. This configuration
enables the Adaptive Suite to communicate with IP Office via TAPI. Open the program Adaptive
Management Console as shown below.

NMS Adapiive Engineer

\g Manage Your Server 5! My Computer
Gl———{ o H- - . - 1 ’

SRl Command Pro o) windows Catalog
. % windows Update %
(__ / windows Expl =1 winzip

. I@ Accessories i ——
“;J-‘ Adaptive Desktr |- iniskrak
S i [T Administrative Tools »
R ) Dell Accessories »
@ Notepad ) Startup »
(— [T Symantec Client Securit »
Adaptive Manat @ Y x
Console ) WinPcap 4
[T) WinZip >
@ Adaptive Predic | = wireshark » . Adaptive Desktop
, [T Wisdom-soft ScreenHunter 5 Free M L
Iz WordPad € Internet Explorer % Adaptive MDE Data Extraction 100
1 (%) Outlook Express \~| Adaptive Predictive Dialler
‘g Paint .. Remote Assistance K Uninstall Adaptive Call Recorder

@ Adaptive 4 =X Uninstall Adaptive Server
LG () Microsoft SQL Server 2005 »
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Enter the appropriate credentials into the Adaptive Management Console login screen as
shown.

FR Adaptive Management Console
File Wiew Config Server Activity Resl-Time Historical Display ‘Window Help

Bl,c8l V0

Adaptive Management Console | ® SHARING

Please enter your user name and password.

User name: IAdministlalor

Password: |

[0k | concel | Heb |

F

Once logged in, configure the CTI Gateway Service by clicking on Config in the toolbar at the
top of the screen and under System select CTI Gateway Service as shown below.

BB adaptive Management Console B SHARING

File View _S_e'rver Activity Real-Time Historical Display Window Help

Users and Teams
Message Rules
Dialling Campaigns
Macros and Screen Poj

ing Processor Service

SQL Exporting Service

‘Web Gateway Service

Message Database Administrator
Adaptive Helper Service
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The Adaptive CTI Gateway Configuration window opens. Select Client Server Comms tab
and select TAPI 3" Party for the Telephone system as highlighted below. Click Settings to
configure the TAPI Settings.

FR adaptive Management Console T

File View Config Server Sctivity Real-Time Historical Display  Window  Help
1

T -0l xI

AN Adaptive CTI Gateway Configuration

3 ™ SHARING

— Communication with Adaptive Desktop
" Use P address: T ;
& Use hostname: [NMS_TEST_Server auto-detect |

Port number: |54321

™ Use default telephone extension numbers for users

— Communication with the telephone system

I Telephone system: I TAPI 3id Party || Settings... §

Adaptive Switch Simulator
Go Connect
Inter-Tel Auxess

TAPI 3rd Party

Extensions

Blendi Banned Numbers | Busy Lamp Field Restrictions |
I Client Server Comms I CLI Matching and Contacts List | DoNotDistub

Apply

The TAPI (Third Party) Settings window opens. Click the Avaya IP Office button under the
Line device identification tab and click OK to submit. All other entries are default.
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Click on Dialling properties on the Adaptive CT1 Gateway Configuration window as shown
below.

Adaptive CTI Gateway Configuration

Elending ! Eanned Mumberz Buzy Lamp Field Restrictions I E stengions
Client Server Comms I CLI Matching and Contacts List I Do-Mot-Disturb

— Communication with Adaptive Desktop

= Use P address:

o Use host name:  |MMS_TEST Server auto-detect |
Fart number: |54321

[~ Usze default telephone estension numbers for users

— Communication with the telephone system

Telephone systern: IT'e‘Pl 3rd Party x| Settings... |

I Dialling properties. .. |I

Ok I Cancel | Appl | Help |

Prefix numbers for outside lines and appended numbers are added for the system on this screen.
The information added here is non-specific as it is unique for each site. Once the relevant
information is added, click OK and OK on the Adaptive CTI Gateway Configuration window,
as shown.
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Elending
Client 5

— Communi

" Usell
* Usek

Port numt

I~ Usec

— Communis

Telephon

Dialling Properties U SHARING
— Append digits or characters to all outbound dialled numbers
v When the dialled number is longer than this many digits: |4
append these characters [and then dial): Iu

i > sHarNG [l

I Banned Numbers I Busy Lamp Field Restrictions I Extensions
erver Comms I CLI Matchina and Contacts List l ~ Do-Not-Disturby

Xl

— Special measures when dialling extemal numbers

IV identify a dialled number as exteral (i.e. not a local extension] if it

" starts with these digits: |;j
7% s longer than [digits): |5
in which case:

¢+ before dialling. always prefiz with these digits: |9

" always use this account code: |1

Corcel_|

ok || cancel | s |

Help |

7.2. Configuration of NMS Adaptive Call Recorder

All configuration of Adaptive Call Recorder is done during the installation process and is
therefore outside the scope of these Application Notes. For further information on the Installation
and Configuration of NMS Adaptive Call Recorder please see Section 11 of these Application

Notes.

7.3. Configure Adaptive Desktop
Open Adaptive Desktop as shown below.
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Adaptive Predic 7) Wireshark
I@ Wisdom-soft ScreenHunter 5 Free 4y Adaptive Management Console
Paint € Internet Explorer % Adaptive MDB Data Extraction Tool
: %) Outlook Express |~ #Adaptive Predictive Dialler
WordPad . Remote Assistance X Uninstall Adaptive Call Recorder
@ Adaptive 4 3% Uninstall Adaptive Server
[7) Microsoft SQL Server 2005 »

Log Off @ Shut Down

This opens the Adaptive Desktop window as shown.

B Adaptive Desktop

‘ [T) Accessaries [ E—
% Adaptive Deskt (=) administrative Tools »
: [7) Dell Accessories »
Adaptive Manac -
Console [T Startup >
[T) Symantec Client Security »
Notepad [T) WinPcap »
) winZip »
14
»

N e [3) @ B

all Programs

I Adaptive Desktop = =l

File Message View Help

[Not logged in 4

@
A

_
- y

Microsoft .

Windows Server 2003

"“*Adaptive
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Click on the Login Icon highlighted. This opens the Adaptive Desktop — User Login window,
Enter the required User name and Password and click OK.

Adaptive Desktop - User Login i ':‘.H:r-
Please enter your user name and password.

Username:  [opa

Password: l

— Module P
= Gl 7| Progressive Didlling

I Adaptive Desktop
File  Message View Help I~ SHi5 I Predictive Dialing

= 1= - = Etfai = /ebChat
=¥ ‘

— Automatic login options

‘When the Adaptive Desktop starts on this computer, automatically log
r in using:
q:
& the User name and password entered abiove

Mot logged in

€ the curtent Windows User name

Cancel I Help |

Once OK is clicked above the Set Telephone Extension window opens. Enter the IP Office
extension that is to be associated with the Adaptive Desktop operator and click OK.

Set Telephone Extension | ™ SHARING

Enter your telephone extension number in the box below:

Ixxx»d I~ Remember this extension on this computer
| 0K I Cancel I

I%. Adaptive Desktop ————T—

File Message View Help

53 B gl O S A S
[Not logged in 4

Once logged in, information on messages, calls, and Call Queue is displayed as highlighted
below.

B adaptive Desktop - Op A - <automatic>
File Message Yiew Help

B3@=0 6

Total 0 messages, Ocalls  Call Queue->0,0
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7.4. Configure Voice Call Recording and Call Detail Recording on
Adaptive Server
Open Adaptive Management Console as described in Section 7.1. Click on Config in the menu

at the top of the Adaptive Management Console window and under System click on CT]
Gateway Service as shown below.

KB adaptive Management Console - (11/17/2011 - 11/17/2011 11:59:59 PM) E 3 | —1of %]
File View Server Activity Real-Time Historical Display Window Help

1]

« Users and Teams
Message Rules
Dialling Campaigns

CTI Gate e |
Messaging Processor Service
SQL Exporting Service
Web Gateway Service
Message Database Administrator
Adaptive Helper Service

The Adaptive CTI Gateway Configuration window is opened. Click on the Extensions Tab
and click Add to include the extensions required for monitoring. Click OK once all the required
extensions are added. The extensions added in this window will be reported on for Call Detail
Recording (CDR) and Voice Recording.
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F1 adaptive Management Console - {11/17/2011 - 11/17/2011 11:59:58 PM)
File Miew Config ServerActivity Real-Time Historical Display Window Help
1

E l ? jE=sall A daptive CTI Gateway Configuration

Cient Server Comms | CLIMatching and ContactsLiss | DoNotDistub
Blending | BannedNumbers |  BusyLamp Field Restictions Extensions

Manitor these extensions: Delete |

Instructions:

Can add single extension e.g. 1000

Can add multiple extensions seperated by comma e.g. 1000,1001
Can add range of extensions using hyphen(-) e.g. 1000-1010

Number
8910
8911
8301
8302
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8. Installing the OptiLogix PCI Call Recording card

The High Impedance tap is achieved using an RJ45 Splitter in order to split the E1-ISDN cable
coming from the PSTN to the IP Office PRI link as illustrated below. The split cables then run
into the Avaya IP Office PRI Link and the OptiLogix PCle Call Recording Card installed
into the NMS Adaptive Server.

Avaya IP Office PRI link

PRA Modem

1
1

.|
RJ 45 Splitter

NMS Adaptive Server

OptilLogix PCle
Call Recording Card
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9. Verification Steps

This section illustrates the steps necessary to verify that the NMS Adaptive Call Recorder is
connected to the IP Office correctly.

9.1. Verify that Avaya IP Office TAPI Service Provider is running
correctly

Open Phone Dialer (Windows program installed on all Windows platforms) on the Adpative
Server where TAPI is installed. Click on the Tools menu and select Connect Using. Another box
opens as shown below. Open the Line dropdown box and all the IP Office users should here as
an available line to use.

f 5
4
Windows Server

Microsoft

Choose any line and in the box Number to dial enter a valid IP Office extension number as
shown below and click Dial. The Phone Dialer should successfully call the chosen extension
number.
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& Phone Dialer N

File Edit Tools Help

Number to dial:

T | ]

Currently dialing: 92012
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9.2. Verify that NMS Adaptive Server has CTI functionality

Open Adaptive Management Console as shown in Section 7.1. Click on Server Activity in the
top menu and Telephone Events as shown below.

BB adaptive Management Console

File W¥iew Config Real-Time Historical Display Window Help
Message Processor 3 .
Telephone Events
Data Controller
Web Gateway

CR Archive

Telephone Events and status are displayed in the CTI Gateway window as shown below.

FB adaptive Management Console — _m;lg'ﬂ

Fite Yiew Conofiq Server Activity Resl-Time Historical Display ‘Window Help
W CTI Gateway » SHARING - icd o o] oo |

I Telephone Events and status Save output to file I
|Initialising telephone system - please wait... AI
201111417 16:08:19 linelnitializeE #() succeeded

2011411417 16:08:19 Found 17 devices
201111417 16:08:19 _Dealw/ithTAPIE ventsThreadProc beginning

2011411417 16:08:19
|IineNegotiate.&PNersion for device 0 returned 8000000c (-2147483636), dwaPlVersion = 20000

2011411417 16:08:19
lineNegotiatePlYersion for device 1 returned 8000000c [-2147483636), dwaPlYersion = 20000

2011411417 16:08:19 ¥
< | »

Connected users and extensions

User | Extension | Status
Op A 8910 Available
OpB 8911 Available
administrator Logout
<« | i3
PG; Reviewed: Solution & Interoperability Test Lab Application Notes 23 of 27

SPOC 9/21/2012 ©2012 Avaya Inc. All Rights Reserved. AdpREC_IPORS8




9.3. Verify Call Detail Recording (CDR) Records are being monitored
correctly

Open Adaptive Management Console as shown in Section 7.1. Click on Historical in the top
menu and Call Recordings as shown below.

BB adaptive Management Console = |DL§J

AEiIe View Config Server Activity Real-Time | Historical | Display ﬁiqdow Help

Users >
Extensions
Call Recordings

Campaigns 2
Predictive Dialler »
Queues >
Server >

5 g

-

This opens Historical Call Recordings Report. Under the Title and Time Period tab enter a
suitable Report title and Time Period as shown below.

¥R adaptive Management Console

(A U el VRS EREE Historical Call Recordings Report .-

= ﬁ Title and Time Period | Calls |

Report title: IToday
IV Show time period after report title (e.q. "My report (3/7/2002 - 4/8/2002)'

- Time period
Statt | 77 472012 > |12.00:00 aM=
Finish: | 7/ 472012 x| |11:59.59 PM=
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This opens the Call Recordings Report for the selected time period and information for calls
made and received will be shown as in the example below. Click on any of the calls to playback
the call recording.

FP adaptive Management Console - {271/ S2012 11:59:59 PM) 5 IEllil
File Wiew Config Server Activity  Real-Time Historical Display  Window  Help
:I_ - 5
21O
=10l %]
Skart DatefTime End Diate/Time Duration | GCI LI Called Mu... | Direckion | ompan | Contack -
13/04/2012 10:37:99  18/042012 10;38:02  00:00:03 33330005...,  99000055... Owtbound
18/04/2012 10:37:59 18042012 10:35:01 00:00:02  99999001... 00111111... Inbound
13/04/2012 10:37:99  18/0442012 10;38:03  00:00:04 FEAF0007...  99000077...  Owutbound
1804/2012 10037:59 18042012 10:35:02 00:00:03  99999001... 00111111... Inbound
13/04/2012 10:37:99  18/042012 10;38:02  00:00:03 55550005,,,  99000055,..  Owtbound
1804/2012 10:37:59 18042012 10:35:01  00:00:02 99999002, 00Z22222... Inbound
13/04/2012 10:37:99  18/0442012 10;38:02  00:00:03 FEEF0007...  99000077...  Owutbound |-
18/04/2012 10037:99  16/04)2012 10:36:02  00:00:03 55550005.., 99000055,  Outbound
13/04/2012 10:37:99  18/042012 10;38:01  00:00:02 99999004, ,, 004, Inbound
18/04/2012 10057:99  16/04)2012 10:36:01  00:00:02 GEGS0005... 99000085,  Outhound
183/04/2012 10:37:99  18/0402012 10;36:01  00:00:02  99329004,,, 0044444, Inbound
18/04f2012 10037:99  16/04)2012 10:36:01  00:00002  99999001,,,  0O011111d... Inbound
13/04/2012 10:37:599  18/042012 10;38:02  00:00:03 GEGE0006,,,  990000686,..  Owtbound
18/04/2012 10:37:99  18/04)2012 10;35:02  00:00:03  99999001.,.  00111111... Inbound
13/04/2012 10:37:99  18/042012 10;38:02  00:00:03 GEEE0006,,,  990000686,..  Outbound
18/04/2012 10:37:99  18/04)2012 10;35:02  00:00:03 3380005, 99000085...  Outhound
183/04/2012 10037:59  18/042012 10:36:02  00:00003  99929001,,, 00111111, Inbound
18/04/2012 10:37:99  18/04)2012 10;35:02  00:00:03 ga380005.,.  99000085...  Outhound
13/04/2012 10:37:99  18/04)201Z 10:38:01  00:00:02 FIITO0007...  99000077... Outbound
18/04/201Z 10:37:99  18/04)2012 10:35:02  00:00:03  99999004,,, OO0, Inbound
13/04/2012 11:21:12  18/040201Z 11:21:15  00:00:03 33300005.,,  990000585... Owtbound
18/04/201Z 11:21:12  18/04)2012 11;21:17 00:00:0%  99999001,,. 00111111.., Inbound
13/04/2012 11:21:12  18/040201Z 11:21:12  00:00:00 FITTO0007...  99000077... Owtbound
18/04/2012 11:21:12  18/04)2012 11:21:18 00:00:06  99999001.,. 00111111... Inbound -
| | ®

32% Free Space l_ o

For Help, press F1
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10. Conclusion

As illustrated in these Application Notes the procedures for configuring NMS Adaptive Hybrid
Call Recorder to interoperate with Avaya IP Office R8.0. In the configuration described in these
Application Notes, various types of calls including intra-switch, PSTN, outgoing and incoming
calls were tested. During compliance testing, all test cases were completed successfully as
outlined in Section 2.2.

11. Additional References

This section references documentation relevant to these Application Notes. The Avaya product
documentation is available at http://support.avaya.com.

[1] TAPI Link installation Doc # 15-601034 Issue 11d

[2] TAPI Link Doc # 15-601035 Issue 11f

[3] 1P Office R8 Doc library

The following NMS Adaptive product documentation can be found at
http://nms-adaptive.com/downloads/

PG; Reviewed: Solution & Interoperability Test Lab Application Notes 26 of 27
SPOC 9/21/2012 ©2012 Avaya Inc. All Rights Reserved. AdpREC_IPORS


http://support.avaya.com/
http://nms-adaptive.com/downloads/

©2012 Avaya Inc. All Rights Reserved.

Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and
™ gare registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks
are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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